
 

 

 

DefleMask 
The best chiptune tracker​

 

DefleMask is one of the most ambitious chipmusic projects to date and the first multi 
system chiptune tracker in history. 

It supports a lot of different consoles and old school sound systems and it is 
available for Windows, macOS, Linux, iOS and Android! 

Our mission is to make a single tracker interface for making chiptunes for many 
old school sound chips and make it available for lots of operating systems. 
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DefleMask support so far: 

 

 

Supported Soundchips Supported Systems 

#1: YM2612 Genesis (#1 + #2) 

#2: SN76489 SMS (#2) 

#3: GB SM83 GB (#3) 

#4: HuC6280 PCE (#4) 

#5: 2A03 APU NES (#5) 

#6: SID C64 (#6) 

#7: YM2151 Arcade Machine (#7 + #8) 

#8: PCM Neo Geo (#9) 

#9: YM2610 SMS + FM Sound Unit (#2 + #10) 

#10: YM2413 NES + VRC7 Expansion (#5 + #11) 

#11: VRC7 NES + FDS Expansion (#5 + #12) 

#12: FDS MSX2 (#13 + #14) 

#13: AY8910  

#14: K051649  
​
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Main Interface 
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​​Pattern Matrix 

​​  

In the pattern matrix you can arrange the positions of your song’s parts (patterns). 
It is possible to create different orders for all channels. The pattern matrix is a 
sequencer and it will allow you to control how your song will evolve through time. 

By clicking with the left and right mouse button on the numbers you can increase 
and decrease the value of that index respectively. Also you can hold Ctrl/cmd and 
click to type the number directly! Or click and hold + move left/right! 

The  button will create completely new and fresh patterns for all channels, the 

IDs will be unused ones.  button will delete and  will copy the current 
selected index (horizontal line).​

If you have  enabled you’ll modify only one index per action, if you press it  
all channels will receive your changes at the same time. 

The arrows  will allow you to rearrange your patterns by moving them 
up/down and the double arrow will create a clone of the current index and move it 
to the bottom (the end) of the song. 
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By pressing  you’ll switch to the Alias mode, this is really useful on large songs 
where it is hard to identify what number does what in the pattern matrix: 

  

In this mode each index could be named by pressing Ctrl/cmd+click (tap and hold 
on Touch interface). If it is not named yet, the ID number will be used as Alias and 
the number will blink indicating that a name is required. 

After you set an Alias, it will also be visible on standard IDs view by hovering your 
mouse on each channel. 
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Instrument List 

 

When you start a new song, there is only one default instrument created; you have 

to click on the  icon in order to create a new instrument. You can load  and 

save  instruments too.​
​
You can change the type by clicking on "FM" or "STD" if the current system 
supports both "FM" and "STD" instruments. STD instruments are controlled by 
macros/envelopes, and FM instruments are controlled by its FM envelopes and 
operator registers (explained in detail later).​
​
You can enter on the properties of the instruments by double clicking the 
instrument name or via the menu Window->Instrument Editor. Inside the instrument 
editor, you can name it and edit how it sounds.​

If you want a copy of the instrument, you should click the  button, and a copy 
will be created at the bottom of the list with “COPY” added at the end of the name. 

You can use the  buttons to move them vertically; also by pressing  you 
will delete the selected instrument (all instruments under it will be moved one 
position up). Keep in mind that instruments are referenced by its index number, so 
moving or deleting even unused instruments will affect all the song.​
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If the current system supports PCM Samples or Wavetables, new lines will appear 
at the end of the instrument list in order to enter the samples editor and 
wavetables editor. 

Supported instruments formats for FM patches: 
●​ .dmp (DefleMask preset)  
●​ .bin (RAW SMPS dump)  
●​ .tfi (TFM Music Maker format)  
●​ .y12 (GENS KMod dump)  
●​ .ins (MVS Tracker format) 
●​ .vgi (VGM Music Maker format) 
●​ .opm (YM2151 dumps, you have to select the last instrument in the list to 

load up to 8 opm instruments) 

Supported instruments formats for STD patches: 
●​ .dmp (DefleMask preset)  

​​ 

​​ 

​​ 

​​ 

​​ 

​​ 

​​ 

​​ 

​​ 
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​​Instrument Editor Window​

The instrument editor window in DefleMask is a floating sub window. You can use the title 
bar to drag it horizontally. This is very useful while you are editing a song and you want to 
check the instrument at the same time.​
In order to close the window, you have to press the "X" button at the top right corner of the 
window.​
Because DefleMask is a Multi-System Tracker there are four types of instrument editor 
windows: STD, FM, Wavetables and Samples. 

STD Instruments 

 

The STD Instruments are controlled by Macro/Envelope generators, you can draw 
any type of shape using the mouse (by holding right mouse button or Ctrl/cmd + 
click you can interpolate straight lines), you can also copy notes or volume values 
and paste its inside the Macro, or set a Loop point by clicking in the bottom part of 
the envelope (to remove it, simply click with the right mouse button). 
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FM Instruments 

 

FM Instruments are controlled by many values that change how the envelopes of 
carriers (operators that produce sound) and modulators (operators that modify 
that sound) relate to each other. You can also mute some operators while editing 
an instrument to simplify the creation process (the muting will not have any effect 
on the actual song playback). You can select from 3 different FM editor modes: 
Sliders, Knobs Radial and Knobs Vertical. The difference between the Knobs 
modes is how they will react to the mouse: Radial will follow the mouse in circles 
and Vertical will change only if you move the mouse up and down. You can change 
the values directly with the keyboard if you press Ctrl/cmd+click over the Knob or 
Slider.​
About the sound, FM Synthesis is a very complex synthesis method and its 
explanation is beyond the scope of this manual. Please refer to specific FM 
Synthesizers sound chip manuals to master this wonderful sound synthesis 
method. 

11 

https://deflemask.com/manual.pdf


 
DefleMask Tracker Manual v2.0.0 - https://deflemask.com/manual.pdf

 

 
 
Wavetable Instruments 

 

Some Systems have WAVE Channels, they are edited using the mouse and drawing 
the shape of the desired wave. You can load and save wavetables any time. The  
"Selected Wave" selector allows you to test and preview how that particular 
wavetable sounds. Also you can copy volume or note values from the patterns and 
paste that directly in the graph. 
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Sample Instruments 

 

You can load .wav files into DefleMask in order to use the PCM capabilities of the 
current system selected; the wav files must have 8/16 bits depth. 

You can use a max of 12 samples per bank (all notes from a music keyboard) and 
you can have 12 banks, so a max of 144 samples can be stored in a DefleMask file. 
If you keep adding samples, a new bank will be created and you have to switch 
banks in your song by using EBxx - Set Sample Bank effect. 

Pitch sliders are only a basic speed multiplier, detailed speed control should be 
done in an external digital audio editor. You can tweak the start and end points of 
the samples by dragging the vertical bars at the sides of the waveform. To replace 
a loaded sample, simply reload a new sample over the desired one. To delete a 
sample, click on the trash bin 
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Menu bar

​
File: 

New: Start a song from scratch.​
​ Open: Loads a DMF (DefleMask Module Format) into the tracker. 

Save/Save as: Saves a DMF (DefleMask Module Format). 
Save ROM: Builds a rom for the system. 
Save VGM: Saves the song in .vgm format. 
Save WAV: Saves a WAV file of your song. If the song loops stop it manually. 
About: About screen. 
Quit: Closes the program. 

Edit: 
​ On this menu you can Undo, Redo, Cut, Copy, Paste, Paste Mix (on empty 
spaces it keeps the original values), Delete, Select All and many more pattern and 
selection actions. Some special ones are Clone pattern on write (any new input on 
the pattern will automatically create a clone of the current pattern) and Zap (a 
menu will appear for you to clear specific parts of the module) 
 
Options: 
​ Change System: Select the sound system. 
​ Key Bindings: To customize your keyboard layout. 

Follow cursor: The view will follow the cursor when playing. 
Repeat: The song will repeat on end (use Bxx to repeat on exported files) 
Use bold font: You can select between normal and bold font modes. 
Play on Load: To enable or disable autoplay of a loaded song.  

​ Horizontal effects input: Move to right or down while entering effects. 
​ Basic view: Shows a simplified version of the patterns. 
​ Reset Tutorial: returns to default values. 
​ MIDI config: A list to select from available MIDI IN devices. 

MIDI poly input: If set, you can send chords while playing and recording. 
MIDI velocity: Alters the note volume according to the key press velocity. 
MIDI wheel depth: Sets the pitch bend wheel depth (in semitones). 
Buffer Size: Audio reserve, low values provide less latency at CPU cost. 
instrument Editor Mode: Change the look and feel of the instrument editor. 
File manager: Internal manager or let your OS show file dialogs. 
UI Mode:  Select between Modular or Touch UI modes. 
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Window: 

 
​ Instrument Editor: If selected display instrument editor on-screen. 
​ Piano: Show or hide the piano on-screen. 

Pattern matrix: Show or hide pattern matrix.​
Module Properties: Show or hide module properties.​
Instrument List: Show or hide the instrument list. 
Oscilloscope View: Show or hide the per channel oscilloscope window. 
Effect list: Displays the list of effects for the selected system. 
Reset Layout: Restore to default all values . 
Skins: See  “skins” below. 

 
Speeds, octave, pattern size and step values: 

 
Step: The rows that the tracker will skip when a new command arrives. 
Octave: Sound octave selector, can be changed also by keyboard shortcuts. 
Rows: Rows per pattern. 
Speed A/B: The count of clock ticks (in Hz) of an even row and for an odd row. 
Base Time: The base time value multiplies the speed values.​
NTSC/PAL/Custom: Clock ticks value of the song, NTSC is 60 Hz and PAL is 50 Hz. 
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Patterns  

 

This is the main part of any tracker. Here you can enter notes, effects, volumes and 
instrument changes.  

A row​

​
Row (gray): The number row.​

Note (white): In this place you can put the actual notes that the tracker will play, 
check the Controls chapter for a note-key relation.​

Vol (green): Here you will be able to define a new volume; the max value depends 
on the current system selected.​

Ins (blue): This value will define the instrument that will trigger the note. ​
Effect (red): In order to know the possible effects check the Standard Effects 

chapter + System information of the selected system.​
Value (white): The effect’s parameter.​

NOTES: Colors are only for reference, they depend on the color theme.​
You can add up to 4 effects columns pressing the "+" button in the upper part of 

each channel.​
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Default Controls 
 

General 
COMMAND KEY 
Exit Esc 
Play song/stop Return/F5 
Play pattern Alt+Return/F6 
Play from pos Shift+Return/F7 
Play row Shift+Alt+Return/F8 
Global Play Ctrl+Return (plays all running DefleMask apps) 
Mutes Channel N Ctrl+1/2/3/4/5/6/7/8/9/N 
Recording mode Space 
More/Less step size Ctrl+Add/Ctrl+Subtract 
Quick save Ctrl+S 
Sliders precise change Ctrl+Mouse Wheel over a slider 
Open module Ctrl+O 
New module Ctrl+N 
Poly input switch Ctrl+P 
On-screen piano Shift+P 

Top of Patterns 
COMMAND KEY 
Mute/Unmute channel Click on the button under the channel’s name 
Solo/Unsolo channel Double Click on the button under the channel’s name 

Pattern Matrix 
COMMAND KEY 
Type a new pattern id 

Ctrl/cmd+click on pattern ID (on  mode) 
Type a new pattern alias 

Ctrl/cmd+click on pattern alias (on  mode) 
Change pattern up Left mouse click on pattern ID 
Change pattern down Right mouse click on pattern ID 
Set pattern number to the last one Middle mouse click on pattern ID 
Clone the upper pattern in an unused ID Shift+Left mouse click on pattern ID 
Insert an unused frame 

 button 
Delete current frame 

 button 
Copy Frame to Next Position 

 button 
Move frame up/down 

 buttons 
Move frame to bottom as new 

 button 
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Instrument List 
COMMAND KEY 
New Instrument 

 button 
Delete Last Instrument 

 button 
Copy Selected Instrument 

 button 
Edit Instrument "Edit" button/F1 Key 

Instrument Editor Window 
COMMAND KEY 
Type new value Ctrl/cmd+click on Slider/Knob 
Copy Instrument Shift+Ctrl+C 
Paste Instrument Shift+Ctrl+V 
Next Instrument Alt+Right Arrow Key 
Previous Instrument Alt+Left Arrow Key 
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Patterns 
COMMAND KEY 

Movement Arrow keys 

Move up/down with 4 as step Page up/Page down 

Move through channels Ctrl + left/right 

Move through patterns Ctrl + up/down 

Translate under values down Insert / Alt+down (hold shift to move all the data) 

Move under values up Backspace / Alt+up (hold shift to move all the data) 

Clone pattern on write Ctrl+D 

Go to the first row Home 

Go to the last row End 

Remove selected values Delete 

Multiple selection Ctrl+A 

Custom selection Shift+arrow keys / Click+drag 

Custom selection expand Ctrl+E 

Custom selection shrink Ctrl+W 

Copy Ctrl+C 

Cut Ctrl+X 

Paste Ctrl+V 

Paste and Mix Ctrl+B 

Numerical Values 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E, F (HEX) 

 
 
 

Musical Notes 

 

Note-Off Tab 

Selected value -1     / Transpose note down Ctrl+F1 

Selected value +1    / Transpose note up Ctrl+F2 

Selected value -10   / Transpose note an octave down Ctrl+F3 

Selected value +10  / Transpose note an octave up Ctrl+F4 

Interpolate Values Ctrl+I 

Change current octave input Divide/Multiply (numpad) 
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Docking panels 
Most of the top panels can be dragged around and be rearranged to your liking 
(notable exception: the waveform viewer / playback controls). Just grab the 
triangle at the top left corner of a panel and start dragging! You can stack panels 
together and tabs will appear, so you can focus on a single panel at a time. You 
also can put them side by side by dropping the panel into the split indicator (square 
shaped). Leaving the panels undocked as floating windows is an option as well. 
The possibilities are endless!  

If you end up in a customization you don’t like and would like to go back to the 
default appearance, use the “Reset Layout” command on the Window menu. On 
that same menu, you can also reopen any of the panels that might not be visible. 

 

Try it out! Make yourself at home with DefleMask’s modular interface. 
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Touch Mode 
If you use the Mobile version you will recognize this mode. It can be enabled from 
Options->UI Mode. This is useful in portable devices and touch screen computers. 

 

The floating toolbox (the area with play, record and note off buttons) is where you 
have the most common controls of the tracker. You can Copy, Paste, Undo, move 
the cursor to Home, to the bottom, Lerp (interpolate) some numeric values, 
enable/disable the on screen piano, the record button (if you press & hold the 
record button you’ll enable Clone Pattern On Write to clone the current pattern as 
soon as you put a note on it), by pressing and holding the play button you’ll play 
from cursor, by pressing and holding play pattern button you’ll play the current row. 
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Networking 

DefleMask supports live multiplayer collaboration. With this feature, multiple users 
can compose music together in real time — something no tracker has ever done 
before. 

The system we created under the hood to achieve this is called PareidoLink. You 
can create a session by pressing File->PareidoLink. From there you can set your 
nick name, Create or Join a Room. 

 
The room code is displayed here: 

 
Share it with your friends and start collaborating! 
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Skins 

 

​
Each user has their own preferences when choosing a visual style. 

We prepared more than 40 different skins so you can choose the one that best 
suits you.  

Go to Window->Skins to change to the skin of your choice.  

You can also use the F9 and F10 to switch to the previous/next skins. 
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Enjoy! 

Effects 
​
DefleMask uses Protracker's standard MOD effect enumeration.​
Keep in mind that the next list is only for the standard effects across all the 
systems.​
In order to learn more about what new effects you can use we recommend 
checking that system's category in this manual. 

0xy - Arpeggio  

​
This effect changes the pitch of the note rapidly, the speed of this being set by the 
E0xx – Arpeggio Tick Speed effect. You can trigger 3 different notes: the first one 
is the base note, the second one is note + x semitones, and the third one is note + y 
semitones. The effect will work until the effect is turned off by setting xy to 00.​
 

1xx - Portamento Up  

This effect will change the frequency by adding the xx value on each tick. In other 
words, value xx defines the speed of the portamento. The effect will continue until 
it is turned off by setting xx to 00.​
 

2xx - Portamento Down  

​
This effect will change the frequency by subtracting the xx value on each tick. In 
other words, value xx defines the speed of the portamento. The effect will continue 
until it is turned off by setting xx to 00.​
 

3xx - Porta to note 

 ​
This effect will change the frequency of the previous note to the new note with a 
speed of xx.​
The effect will continue until a new note is triggered, it reaches the pitch of the 
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second note, or the effect is turned off by setting xy to 00.​
 

​
4xy - Vibrato  

​
Changes frequency up and down with specified depth and speed.​
Value x defines speed of the vibrato. 1 is minimum speed, F is maximum speed. 
Value y defines depth of the vibrato. Maximum depth is a full note.​
The effect will continue until the effect is turned off by setting xy to 00. 

 

5xy - Portamento to note and volume slide 

​
Continue the previous 3xx effect and combine the result with a volume slide that 
works like Axy effect.  

 

6xy - Vibrato and volume slide 

​
Continue the previous 4xx effect and combine the result with a volume slide that 
works like Axy effect.  

 

7xy - Tremolo 

Similar to the vibrato, but changes the volume amplitude instead of the pitch. x for 
speed, and y for depth. 

​
8xx - Panning 

​
Panning will change the sound output of the channel to the right or the left 
speakers, normally it is 0x01 right, 0x10 left, and 0x11 both. However, some 
systems have different stereo behavior. You will need to check these individually.​
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​
 

9xx - Set Speed Value 1 

This command will set the playback speed 1 dynamically. 

 

Axy - Volume Slide​
 

Volume slide up/down. Positive x value and zero y value defines speed of the 
volume slide going up, positive y value and zero x value defines speed of the 
volume slide going down. 

 

Bxx - Position Jump 

This command will make the cursor jump to pattern position xx (hex). With xx 
lower than the current pattern index you can create a looped track, the loop 

entrance point will be marked with corners in the 
pattern matrix.​
Please take into account that only the first loop command (Bxx going to a previous 
position) will be taken into account. If you have more they will be ignored. 

​
Cxx - Retrig 

​
Retrig the current note xx times on a tick. If the parameter xx is equal or higher 
than tick time, the effect is ignored. This effect will work until the row ends. 

 

Dxx - Pattern Break 

​
This command will stop playing the current pattern and will jump to the next one in 
the pattern matrix. You can also select which row to start on in the next pattern. 
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Note that the specified row xx is in Hex. This effect will not work on the last pattern 
of the song, because there is no "next pattern". If you want to make a loop, use Bxx 
instead. 

 

Exx - Extended Commands  

- E0xx – Arpeggio Tick Speed: Use xx to define the speed of the arpeggio 
(00xy) effect. Bigger numbers are slower.​
- E1xy - Note Slide Up: Use x to define the speed, and y to define the number 
of semitones to increment. This effect is similar to 3xx - Portamento to 
Note. ​
- E2xy - Note Slide Down Use x to define the speed, and y to define the 
number of semitones to decrement. This effect is similar to 3xx - 
Portamento to Note. ​
- E3xx - Set Vibrato Mode: This command will define vibrato mode, 1 UP 
ONLY (like guitars), 2 DOWN ONLY, 0 both/normal mode. ​
- E4xx - Set Fine Vibrato Depth: This command will define the fine vibrato 
depth, default value is F. ​
- E5xx - Set Fine Tune: This command will change notes pitch in a precise 
way, it is a fine tweak offset with origin in E580. E5FF goes to the current 
note + 1 semitone, E500 is the current note – 1 semitone.​
- EAxx - Set Legato Mode: Setting xx to 1 will prevent next notes from 
restarting the envelope.​
- EBxx - Set Samples Bank: This command will change the current sample 
bank to xx. A max of 12 sample banks can be used, from 0 to 11. ​
- ECxx - Note Cut: This command will rapidly cut a triggered note. A value 
greater than the speed of the current row will be ignored. ​
- EDxx - Note Delay: This command will delay a note for a short period of 
time.​
A value greater than the speed of the current row will be ignored.​
- EExx – Sync Signal: To be used in .vgm exports for synchronization with 
visuals or other devices. It writes a data block of type FF size 3 with register 
0x00 0x00 and DATA xx. In Hex: 67 66 FF 03 00 00 00 00 00 xx ​
- EFxx - Set Global Fine Tune: This command will add or subtract to the 
global pitch of the entire song, a value greater than 80 will add, and a value 
lower than 80 will subtract (this effect is cumulative).  
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Fxx - Set Speed Value 2 

​
This command will set the playback speed 2 dynamically. 

 

Systems 

Information 
 
In this section, each system will be briefly described alongside the full effects list 
available for it.  
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Genesis 

 
 
 
 
Soundchip 1: YM2612​
Soundchip 2: SN76489 
Max Volume: 7F (Soundchip 1), F (Soundchip 2) 
 
 
You can also select Genesis (EXT.CH3) mode. This mode divides the FM channel 3 
into its 4 operators to control the frequency of them freely. This can increase the 
polyphony to 4 more channels of sine waves (if you use Algorithm 4), make 2 ops 
instruments among other cool effects. 
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Effects: 
 

FM: 

10xy - LFO Control 
This effect controls the Low Frequency oscillator of the YM2612.​
A non-zero value on x turns the LFO on.​
The y value controls the speed of the LFO, you can set a value from 0 to 7. 

11xx - Feedback Control 
The FB is a global parameter of a YM2612's channel. You can designate xx with a 
value from 0 to 7. 

12xx - TL Operator 1 Control 
With this effect you can modify the TL of the operator 1. You can designate xx with 
a value from 0 to 7F. 

13xx - TL Operator 2 Control 
With this effect you can modify the TL of the operator 2. You can designate xx with 
a value from 0 to 7F. 

14xx - TL Operator 3 Control 
With this effect you can modify the TL of the operator 3. You can designate xx with 
a value from 0 to 7F. 

15xx - TL Operator 4 Control 
With this effect you can modify the TL of the operator 4. You can designate xx with 
a value from 0 to 7F. 

​
16xy - MULT Control 
The Multiplier factor is a frequency multiplier. All 4 operators are capable of having 
independent MULT values.​
The x value is the operator to modify, you can designate a value from 1 to 4. 
The y value controls the MULT value; you can designate a value from 0 to F. 
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17xx - DAC Enable 
This effect will enable the sample features of the last FM Channel. 
A non-zero value will enable the sample output, and a zero value will disable it. 
 

18xx – EXT. CHN3 Mode Enable 
This effect will disable/enable the independent frequency for operators. Only 
available in Genesis (Ext. CH3) 
 

19xx - Global AR Control 
This effect will control all the AR values of all operators of the current instrument.​
Values higher than 0x1F (31) will be ignored. 
 

1Axx - AR Operator 1 Control 
This effect will control the AR value of the operator number 1 of the current 
instrument. Values higher than 0x1F (31) will be ignored. 

​
1Bxx - AR Operator 2 Control 
This effect will control the AR value of the operator number 2 of the current 
instrument. Values higher than 0x1F (31) will be ignored. 

​
1Cxx - AR Operator 3 Control 
This effect will control the AR value of the operator number 3 of the current 
instrument. Values higher than 0x1F (31) will be ignored. 

​
1Dxx - AR Operator 4 Control 
This effect will control the AR value of the operator number 4 of the current 
instrument. Values higher than 0x1F (31) will be ignored.​
​
 

PSG: 

For effects and other details about the SN76489, see its section under “SMS”. 
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SMS 

 

 

 

Soundchip: SN76489 

Max Volume: F 

A maximum of 4 notes can be sounded on the SN76489 if the noise mode is not in 
the special mode, if it is, a maximum of 3 notes can be sounded. 

 

 

 

 

 

33 

https://deflemask.com/manual.pdf


 
DefleMask Tracker Manual v2.0.0 - https://deflemask.com/manual.pdf

 

 
 
Effects: 

20xy - Change Noise Mode: 
This effect only works on SN76489 (PSG) channels.​
This effect will change the way in which the SN76489 makes the noise.​
Value x sets the special noise mode, if it is set to 0 only 3 frequencies are available: 
C, C# and D.​
If it is set to 1, the noise can reach any frequency at the cost of losing the third 
Square channel.​
Value y sets the type of noise, setting it to 0 will enable the periodic noise mode, if 
it is set to 1, white noise generation will be enabled.​
Keep in mind that, after changing this value, you have to play the current track in 
order to update the emulator noise mode. 
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GB 

 

Soundchip: Sharp SM83 

Max Volume: F on SQ1/SQ2/Noise Channel, 3 on WAVE Channel. 

Attention!: Due to how volume is handled inside the sound chip, you should always 
use Volume Envelopes to shape your volume fades (with the exception of the 
Wavetable channel). Using the volume column directly is only available at the start 
of the notes, while the note is sounding the volume envelope controls it all. 

The WAVE channel volume can be controlled by the “Duty Cycle/Noise Mode/Wave 
Volume Macro”, this is a general purpose envelope that acts differently on each 
channel. Previous versions of DefleMask didn’t have this option, so keep an eye on 
this if you have strange volume behavior on your wavetables on old .dmf files. 
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Effects: 

10xx - Set WAVE: 
This effect will change the current wave defined in the WAVE Channel Instrument 
Editor Window. 
​
11xx - Set Noise Polynomial Counter Mode: 
This effect will set the current Polynomial counter for the Noise Channel, 0 will set 
it to 15 steps, and 1 will set it to 7. 
​
12xx - Set Duty Cycle/Noise Mode/Wave channel volume: 
If you use this effect on a Square Channel you will set the Duty Cycle, xx can be 
0=12.5%, 1=25%, 2=50% and 3=75%. If you are in the Noise Channel you will 
change the noise mode (0 or 1). If you use this on the Wave channel you will set the 
volume of it.You can change this too by using the Macro of the instrument. 

​
13xy - Set Sweep Time and Shift: 
Value x will set the Sweep time, and value y will set the Sweep Shift. Both have a 
valid range from 0 to 7. A zero value will disable the sweep. 
​
14xx - Set Sweep Direction: 
A zero value will make the sweep go upwards, a non-zero value downwards. 
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PCE 

 

 
 

Soundchip: HuC6280 
Max Volume: 1F 
​
The stereo 08xy effect in PC Engine is X for LEFT and Y for Right. 0-F values are 
allowed. 

You can use the Wave Macro to turn off and on the noise mode: 63 = ON, 62 = OFF 
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Effects: 

​
10xx - Set WAVE: 
This effect will change the current wave defined in the WAVE Channel Instrument 
Editor Window. 
​
11xx - Enable Noise Channel: 
This effect will enable the features of the Channels 5 and 6 to produce Noise, a 
value different from zero will enable the noise channel in the current channel. This 
command will only take Effect in channels 5 and 6. 
​
12xx - Set LFO Mode: 
Enabling the LFO will mute CH2. This effect will set the current LFO mode, a value 
of 00 will turn off the LFO, a value of 01 will add the LFO data directly to CH1 
frequency, a value of 02 will shift the LFO data left by four places and then it will be 
added to the CH1 frequency, a value of 03 will shift left the LFO data by eight 
places and then it will be added to the CH1 frequency. 
​
13xx - Set LFO Speed: 
This effect will set the LFO speed if it is enabled by 12xx effect. 
​
17xx - Enable Sample Output: 
Setting xx to 1 will enable the sample output in the selected channel while setting it 
to 0 will enable the wavetable output. 
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NES 

 

 

​
Soundchip: 2A03 (APU) 
Max Volume: F 
You have 5 channels, 2 square channels with variable duty cycle, a Triangle 
Channel, a Noise Channel and a 7 Bits PCM channel (RAW PCM NES Samples) 
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Effects: 

​
12xx - Change Duty Cycle/Noise Mode: 

This effect will change the duty cycle or the noise output mode.​
If you are in a square channel (SQ1 or SQ2) you will change the Duty Cycle 
(possible values are 00, 01, 02 and 03). If you are in the Noise Channel (NOI) you 
will change the noise mode. Possible values are 00 and 01. Keep in mind that you 
can change them too by using the Duty Cycle Macro of the instrument. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

C64 
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​
 

 

 

 

 

 

 

Soundchip: MOS SID 

Max Volume: F (global parameter of the sound chip) 

You have 3 channels, with selectable Waveforms (Triangle, Saw, Noise, Pulse) and 
ADSR generators.​
DefleMask supports two SID versions (6581 and 8580) and the differences are: 
better mixing of waveforms for the 8580, and more aggressive filters for 6581. 

WARNINGS: When we switch from a slow to a fast envelope rate the generator can 
get stuck for about 30 ms. If some of your notes are not triggering try to increase 
the ADSR Hard Reset Time (effect 15xx). 

All channels use the same filter. Use only one instrument at a time that has 
“Initialize the filter” checked. 
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Effects: 

 
10xx - Set WAVE: 
This effect will directly set the waveform for the current channel. The parameter is 
a 4bits bitmask:​
0 = No Wave 
1 = Triangle 
2 = Saw 
3 = Triangle + Saw 
4 = Pulse 
5 = Pulse + Triangle 
6 = Pulse + Saw 
7 = Pulse + Triangle + Saw 
8 = Noise 
 
11xx - Filter Cutoff Set: 
This effect will set the filter cutoff to a specific value, you can set values from 0 to 
64 (hex). 
 
12xx - Pulse Width Set: 
This effect will set directly the pulse width; xx could be from 0 to 64. 
 
13xx - Filter Resonance Set: 
This effect will change the current Filter Resonance value, xx goes from 0 to F. 
 
14xx - Filter Mode Set: 
xx is a bitmask to enable or disable the filter modes:​
0 = Filter Disabled.​
1 = Low Pass Enabled.​
2 = Band Pass Enabled.​
3 = Low Pass Enabled, Band Pass Enabled​
4 = High Pass Enabled.​
5 = Low Pass Enabled, High Pass Enabled.​
6 = Band Pass Enabled, High Pass Enabled.​
7 = Low Pass Enabled, Band Pass Enabled, High Pass Enabled. 
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15xx - ADSR Hard Reset Time Set: 
This effect will set the amount of frames that the ADSR Reset effect (1Axx) will 
take to perform the reset of the envelope, a value of 3 should be enough to avoid all 
types of ADSR Bugs present in the SID (default value: 1). 
 
1Axx - ADSR No Reset: 
This effect will prevent the reset of the ADSR on note on, if xx is a non-zero value, 
then all the next notes of the channel will continue the envelope, a value of zero will 
reset the ADSR on every note on (keep in mind that the SID chip has a bug 
regarding to the ADSR, to reset it effectively the software should wait some frames, 
you can set the count of frames to wait using 15xx effect). 
 
 
​
1Bxy - Filter Cutoff Reset: 
This effect will reset the filter cutoff to the current instrument filter cutoff, very 
useful to finish a Dynamic Macro Filter Cutoff change. A y value different from zero 
will change it instantly, and the x value, if it is not set to zero, will reset it on every 
new note. Keep in mind that the filter cutoff is a global value on the Commodore 
64, so this command will change the behavior of all the channels that are using the 
filter. 
​
1Cxy - Pulse Width Reset: 
This effect will reset the pulse width to the current instrument pulse width, very 
useful to finish a Dynamic Macro Pulse Width change. A y value different from zero 
will change it instantly, and the x value, if it is not set to zero, will reset it on every 
new note. 
 
 
1E0X - Extended 0 - Attack Set: 
This effect will change dynamically the attack of the selected channel. x can go 
from 0 to F. 
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​
1E1X - Extended 1 - Decay Set: 
This effect will change dynamically the decay of the selected channel. x can go 
from 0 to F. 
​
1E2X - Extended 2 - Sustain Set: 
This effect will change dynamically the sustain of the selected channel. x can go 
from 0 to F. 
​
1E3X - Extended 3 - Release Set: 
This effect will change dynamically the release of the selected channel. x can go 
from 0 to F. 
​
1E4X - Extended 4 - Ring Modulation Set: 
This effect will set or clear the ring modulation of the selected channel. x can be 0 
or 1. 
​
1E5X - Extended 5 - Sync Set: 
This effect will set or clear the sync of the selected channel. x can be 0 or 1. 
​
1E6X - Extended 6 - Channel 2 OFF Set: 
This effect will set the CH2OFF command of the SID's chip dynamically. x can be 0 
or 1. 
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Arcade 

 

Soundchips: YM2151 + PCM 
Max Volume: 7F 
 
Effect 08xy: Soft stereo! x is the left speaker and y is the right speaker (0 to F). 
Max sample rate of PCM data is 31250hz 
 
 
 

45 

https://deflemask.com/manual.pdf


 
DefleMask Tracker Manual v2.0.0 - https://deflemask.com/manual.pdf

 

 
 
Effects: 
​
FM: 
​
10xx – Noise Mode Set: 
This effect will enable the noise output of the 4th operator of the last FM channel. 
00 means disabled, standard behavior as a FM operator. From 0x01 to 0x20 (HEX) 
you will set the white noise frequency. This provides independence from the main 
frequency of the other operators (to make noise and kick at the same time at 
different pitches, for example) 
 
11xx - Feedback Control: 
The FB is a global parameter of a YM2612's channel. You can designate xx with a 
value from 0 to 7. 
​
12xx - TL Operator 1 Control: 
With this effect you can modify the TL of the operator 1. You can designate xx with 
a value from 0 to 7F. 
 
13xx - TL Operator 2 Control: 
With this effect you can modify the TL of the operator 2. You can designate xx with 
a value from 0 to 7F. 
 
14xx - TL Operator 3 Control: 
With this effect you can modify the TL of the operator 3. You can designate xx with 
a value from 0 to 7F. 
 
15xx - TL Operator 4 Control: 
With this effect you can modify the TL of the operator 4. You can designate xx with 
a value from 0 to 7F. 
​
16xy - MULT Control:​
The Multiplier factor is a frequency multiplier. All 4 operators are capable of having 
independent MULT values.​
The x value is the operator to modify, you can designate a value from 1 to 4. 
The y value controls the MULT value; you can designate a value from 0 to F. 
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17xx – Set LFO Speed: 
This effect will set the LFO’s speed. It starts disabled (00), the max value is FF. 
​
18xx – Set LFO Waveform: 
This effect will change the LFO waveform, 0 SAW, 1 SQUARE, 2 TRI, 3 NOISE. 
 
19xx - Global AR Control:​
This effect will control all the AR values of all operators of the current instrument.​
Values higher than 0x1F (31) will be ignored. 
​
1Axx - AR Operator 1 Control:​
This effect will control the AR value of the operator number 1 of the current 
instrument. Values higher than 0x1F (31) will be ignored. 
​
1Bxx - AR Operator 2 Control:​
This effect will control the AR value of the operator number 2 of the current 
instrument. Values higher than 0x1F (31) will be ignored. 
​
1Cxx - AR Operator 3 Control:​
This effect will control the AR value of the operator number 3 of the current 
instrument. Values higher than 0x1F (31) will be ignored. 
​
1Dxx - AR Operator 4 Control:​
This effect will control the AR value of the operator number 4 of the current 
instrument. Values higher than 0x1F (31) will be ignored. 
​
1Exx - AM/PM Depth:​
This effect will control the Amplitude Modulation Depth and Phase Modulation 
Depth. The highest bit controls AMD/PMD (0/1). The other 7 bits specify the depth. 
AMD: 00~7F. PMD: 80~FF. Initially both are at their max value. 
 
PCM: 
​
20xx – Set Sample Delta: 
This effect will set the speed of sample playback, very useful to make tonal 
samples. The formula is: delta*(31250/255)hz = sample hz 
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Neo Geo 

 

 
 
 
Soundchips: YM2610 
Max Volume: 7F on FM, 1F on ADPCM. 
 
ADPCM sampling rate is 18.5khz 
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Effects: 
​
FM: 
​
10xy - LFO Control: 
This effect controls the Low Frequency oscillator of the YM2612.​
The x value set if the LFO is on or off,  a non-zero value turns the LFO on.​
The y value controls the speed of the LFO, you can set a value from 0 to 7.​
​
11xx - Feedback Control: 
The FB is a global parameter of a YM2612's channel. Values higher than 7 will be 
ignored. 
​
12xx - TL Operator 1 Control: 
With this effect you can modify the TL of the operator 1. Values higher than 7F will 
be ignored. 
 
13xx - TL Operator 2 Control: 
With this effect you can modify the TL of the operator 2. Values higher than 7F will 
be ignored. 
 
14xx - TL Operator 3 Control: 
With this effect you can modify the TL of the operator 3.Values higher than 7F will 
be ignored. 
 
15xx - TL Operator 4 Control: 
With this effect you can modify the TL of the operator 4.Values higher than 7F will 
be ignored. 
​
16xy - MULT Control:​
The Multiplier factor is a frequency multiplier. All 4 operators are capable of having 
independent MULT values.​
The x value is the operator to modify, you can designate a value from 1 to 4.The y 
value controls the MULT value; you can designate a value from 0 to F. 
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17xx - DAC Enable:​
This effect will enable the sample features of the last FM Channel. 
A non-zero value will enable the sample output, and a zero value will disable it. 
 
18xx – EXT. CHN2 Mode Enable:​
This effect will disable/enable the independent frequency for operators. Only 
available in Neo Geo (Ext. CH2) 
 
19xx - Global AR Control:​
This effect will control all the AR values of all operators of the current instrument. 
Values higher than 1F will be ignored. 
​
1Axx - AR Operator 1 Control:​
This effect will control the AR value of the operator number 1 of the current 
instrument. Values higher than 1F will be ignored. 
​
1Bxx - AR Operator 2 Control:​
This effect will control the AR value of the operator number 2 of the current 
instrument. Values higher than 1F will be ignored. 
​
1Cxx - AR Operator 3 Control:​
This effect will control the AR value of the operator number 3 of the current 
instrument. Values higher than 1F will be ignored. 
​
1Dxx - AR Operator 4 Control:​
This effect will control the AR value of the operator number 4 of the current 
instrument. Values higher than 1F will be ignored. 
​
​
SSG: 
​
20xx – Set Channel Mode: 
0 square, 1 noise, 2 both. 
 
21xx – Set Noise Tone: 
00...1F Set noise frequency. 
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SMS + FM Sound Unit 
 

 

Soundchip: SN76489 + YM2413​
Max Volume: F 

You can only have 1 custom FM preset at a time and edit every parameter of the 
synth, however, when using some of the pre-selected instruments you can only 
control the volume by using OP2 TL. 

A "Drum kit" is a special kind of instrument that uses FM7, FM8 and FM9 channels 
for creating percussions sounds. It will only work on those channels and your 
notes become: C Kick, C# Snare, D Tom-Tom, D# Top Cymbal, E High Hat 
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Effects: 

SN76489: 

20xy - Change Noise Mode: 
This effect only works on SN76489 (PSG) channels.​
This effect will change the way in which the SN76489 makes the noise.​
Value x sets the special noise mode, if it is set to 0 only 3 frequencies are available: 
C, C# and D.​
If it is set to 1, the noise can reach any frequency at the cost of losing the third 
Square channel.​
Value y sets the type of noise, setting it to 0 will enable the periodic noise mode, if 
it is set to 1, white noise generation will be enabled.​
Keep in mind that, after changing this value, you have to play the current track in 
order to update the emulator noise mode. 
 
 
YM2413: 
 
11xx - Feedback Control: 
The FB is a global parameter of a YM2413's channel. 
You can designate xx with a value from 0 to 7. 
 
12xx - TL Operator 1 Control: 
With this effect you can modify the TL of the operator 1. 
You can designate xx with a value from 0 to 3F. 
 
13xx - TL Operator 2 Control: 
With this effect you can modify the TL of the operator 2. 
You can designate xx with a value from 0 to F. 
 
16xy - MULT Control: 
The Multiplier factor is a frequency multiplier. 
All 2 operators are capable of having independent MULT values. 
The x value is the operator to modify, you can designate a value from 1 to 2. 
The y value controls the MULT value; you can designate a value from 0 to F. 
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19xx - Global AR Control: 
This effect will control all the AR values of all operators of the current 
instrument. 
Values higher than F (15) will be ignored. 
 
1Axx - AR Operator 1 Control: 
This effect will control the AR value of the operator number 1 of the current 
instrument. Values higher than F (15) will be ignored. 
 
1Bxx - AR Operator 2 Control: 
This effect will control the AR value of the operator number 2 of the current 
instrument. Values higher than F (15) will be ignored. 
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NES + VRC7 Expansion 

 

Soundchip: 2A03 (APU) + VRC7 

Max Volume: F 
You have 11 channels, 2 square channels with variable duty cycle, a Triangle 
Channel, a Noise Channel, a 7 Bits PCM channel (RAW PCM NES Samples) and 6 
FM channels. 
You can only have 1 custom FM preset at a time and edit every parameter of the 
synth, however, when using some of the pre-selected instruments you can only 
control the volume by using OP2 TL. 

The full list of FM presets are: Custom, Buzzy Bell, Guitar, Wurly, Flute, Clarinet, 
Synth, Trumpet, Organ, Bells, Vibes, Vibraphone, Tutti, Fretless, Synth Bass, Sweep. 

 

54 

https://deflemask.com/manual.pdf


 
DefleMask Tracker Manual v2.0.0 - https://deflemask.com/manual.pdf

 

 
 
Effects: 

2A03:​
12xx - Change Duty Cycle/Noise Mode: 
This effect will change the duty cycle or the noise output mode.​
Duty cycle possible values are 00, 01, 02 and 03, noise are 00 and 01. 
 
VRC7: 
11xx - Feedback Control: 
The FB is a global parameter of a YM2413's channel from 0 to 7. 
 
12xx - TL Operator 1 Control: 
With this effect you can modify the TL of the operator 1 from 0 to 3F. 
 
13xx - TL Operator 2 Control: 
With this effect you can modify the TL of the operator 2 from 0 to F. 
 
16xy - MULT Control: 
The Multiplier factor is a frequency multiplier. 
All 2 operators are capable of having independent MULT values. 
The x value is the operator to modify, from 1 to 2. 
The y value controls the MULT value, from 0 to F. 
 
19xx - Global AR Control: 
This effect will control all the AR values of all operators of the current 
instrument. 
Values higher than F (15) will be ignored. 
 
1Axx - AR Operator 1 Control: 
This effect will control the AR value of the operator number 1 of the current 
instrument. Values higher than F (15) will be ignored. 
 
1Bxx - AR Operator 2 Control: 
This effect will control the AR value of the operator number 2 of the current 
instrument. Values higher than F (15) will be ignored. 
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NES + FDS Expansion 
 

 

 

Soundchip: 2A03 (APU) + FDS 

Max Volume: F on 2A03, 20 on FDS 
You have 6 channels, 2 square channels with variable duty cycle, a Triangle 
Channel, a Noise Channel, a 7 Bits PCM channel (RAW PCM NES Samples) and a 
wavetable channel. 
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Effects: 

2A03:​
12xx - Change Duty Cycle/Noise Mode: 
This effect will change the duty cycle or the noise output mode.​
If you are in a square channel (SQ1 or SQ2) you will change the Duty Cycle 
(possible values are 00, 01, 02 and 03). If you are in the Noise Channel (NOI) you 
will change the noise mode. Possible values are 00 and 01. Keep in mind that you 
can change them too by using the Duty Cycle Macro of the instrument. 
 

FDS: 
10xx - Set WAVE 
This effect will change the current wavetable used in this channel. 
 
11xx - Set modulation depth 
Waveform modulation depth, max 3F. 
 
12xy - Set modulation high frequency part and enable 
x will turn on (1) or off (0) the modulation, and y will set the high part of the freq 
register. 
 
13xx - Set modulation low frequency part 
Sets the low frequency part of the modulation register. 
 
14xx - Modulation position 
This effect will set the modulation phase position. Max 7F. 
 
15xx - Set Modulator WAVE 
This effect will set which waveform will be used as a modulator waveform. 
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MSX2 

 
Soundchip: AY8910 + K051649 (SCC) 

Max Volume: F 
AY chip has 3 square/noise channels (see effect 11xx and channel mode macro).​
SCC chip has 5 wavetable channels, channel 4 and 5 share the wavetable. 
 
Effects: 

SCC: 

10xx - Set WAVE: 
This effect will change the current wave defined in the WAVE Channel Instrument 
Editor Window. 
 

AY:​
11xx - Set Channel Mode: 
0 square, 1 noise, 2 both. 
 
12xx - Set Noise Tone: 
00...1F set noise frequency. 
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Get in touch! 

 

 

​
 
​

https://www.deflemask.com  
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https://www.pareidolabs.com​

 
 

All trademarks and company names are the property of their respective owners. 
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	5xy - Portamento to note and volume slide 
	6xy - Vibrato and volume slide 
	7xy - Tremolo 
	​8xx - Panning 
	9xx - Set Speed Value 1 
	Axy - Volume Slide​ 
	Bxx - Position Jump 
	​Cxx - Retrig 
	Dxx - Pattern Break 
	Exx - Extended Commands  
	Fxx - Set Speed Value 2 

	 
	Systems Information 
	 
	 
	 
	 
	Effects: 
	10xy - LFO Control 
	11xx - Feedback Control 
	12xx - TL Operator 1 Control 
	13xx - TL Operator 2 Control 
	14xx - TL Operator 3 Control 
	15xx - TL Operator 4 Control 
	​16xy - MULT Control 
	17xx - DAC Enable 
	18xx – EXT. CHN3 Mode Enable 
	19xx - Global AR Control 
	1Axx - AR Operator 1 Control 
	​1Bxx - AR Operator 2 Control 
	​1Cxx - AR Operator 3 Control 
	​1Dxx - AR Operator 4 Control 

	PSG: 



